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3D Captured Data Visualization and Recognition using MeshLab – 
A Tutorial 

 
Last Updated: February 19, 2024 

 
This Tutorial Provides a step-by-step guidance to use MeshLab for 3D data visualization and 
recognition. Specific examples are provided to ease the learning process.  
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1. MeshLab Installation  
 
MeshLab is a versatile open-source software tool designed for manipulating 3D models. Its 
comprehensive features include editing, cleaning, healing, inspecting, rendering, texturing, and 
converting meshes. Additionally, MeshLab offers capabilities to process raw data from 3D 
measurement devices, making it invaluable for 3D printing purposes. 
 
For more detailed information about this software tool, you can visit its homepage at MeshLab 
Homepage. 
 
To access this software tool, you can download it through the MeshLab Download. On the 
download page, as shown in Figure 1 below, you will find the package that corresponds to your 
computer's operating system. Simply select the appropriate package and proceed to install the 
software on your computer, following the standard installation process similar to other regular 
software. 
 

 
Figure 1. MeshLab download page. 
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2. 3D Data Loading 
2.1: Loading 3D data through “File” tab at the menu bar 
 

 
Figure 2. Load 3D model through "File" tab 

2.2: Loading 3D data through “Import Mesh” quick access button 
 

 
Figure 3. Import mesh quick access button 

2.3: Drag & drop the 3D data file onto GUI directly 
 

 
Figure 4. Drag and drop the 3D model file 

 
For a comprehensive guide on features in section 2, please refer to the detailed steps provided in 
the demo video: MeshLab Demo Video -- Loading 3D data. 
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3. MeshLab Graphical User Interface (GUI) 
 
The provided image, as shown in Figure 5, displays the graphical user interface of MeshLab, 
with prominently highlighted function buttons and windows in red. These buttons serve as 
essential tools, empowering users to perform fundamental manipulations on their loaded 3D 
models. For more sophisticated operations, users can access advanced functionalities through the 
"Filters" or "Render" options in the menu bar. 

 

 
Figure 5. MeshLab graphical user interface (GUI) 
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4. 3D Model Visualization and Manipulation 
 
4.1: 3D model rotation and pan moving 
 

 
Figure 6. 3D model of a shoe bottom in MeshLab. 

Figure 6 displays a three-dimensional (3D) model of the bottom of a shoe, as visualized in 
MeshLab. After importing either a. PLY or .STL file into MeshLab, you can rotate the 3D model 
by holding down the left mouse button and dragging to achieve the desired orientation, as 
illustrated below in Error! Reference source not found.. 
 
At this point, the 3D model retains its original coordinate system. To adjust the model's position, 
you can utilize the "Pan" function in MeshLab. To do this, simply use the mouse's middle button 
to drag the model to your desired location. Beneath, Figure 8 illustrates the three-dimensional 
(3D) model of the shoe's underside following random panning.. Ideally, you should aim to align 
the centroid of the 3D model with the origin of the display coordinates. 
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Figure 7. 3D model of shoe bottom after rotation. 

 
Figure 8. 3D model of shoe bottom after random panning. 
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4.2: 3D model rendering mode 
 
Upon initially importing a. PLY or .STL file into MeshLab, the software applies a default setting 
to the 3D model's display. You have various rendering options for the model, including point 
cloud, wireframe, and smooth surface modes. Combined display modes, such as point cloud + 
smooth surface, are also supported. To adjust the display mode, you can use the buttons 
highlighted in red. For additional clarification on each button's function, simply hover your 
mouse over it to view its corresponding label. The buttons accentuated in purple govern the 
presentation of detailed settings associated with each display mode. 

 

 
Figure 9. 3D model rendering mode control 

4.2.1: Render 3D model in Point cloud mode  
 
To render the 3D model in Point Cloud, please click on the Point Cloud mode icon . You can 
adjust the point size using the slider bar. The Figure 10 below illustrates the same 3D model, but 
with different point sizes for comparison. For shading options, you can choose between "Vertex", 
“Dot Decorator”or "None". “Vertex” relies on GPU to interpolate normal across the triangles 
formed by closest points. The lighting is disabled with “None” selected. The color can be set to 
either "Mesh" or "User-Defined". “Mesh” can render the 3D model with initial color, while the 
“User-Defined” can control the color based on the user’s preference. Settings for shading, color, 
and point size are highlighted in red for easy identification. 
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(a) 

 
(b) 

Figure 10. 3D model in point cloud mode with varied point size. (a) small point size; (b) large point size. 
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4.2.2: Render 3D model in wireframe mode 
 
Like the point cloud settings, the wireframe settings can be found in the area highlighted in red. 
You can adjust the width of the edges for the triangles in the wireframe using the slider bar. The 
subsequent images, presented in Figure 11, depict the same segment of the 3D model in 
wireframe mode, showcasing variations in edge width. 
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(a) 

 
(b) 

Figure 11. 3D model in frame wire mode with varied edge width. (a) small width; (b) large width; 
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4.2.3: Render 3D model in smooth surface mode  

 
The smooth surface rendering option displays the 3D model with a seamlessly connected surface, 
as shown in Figure 12 below. It offers three main settings: Shading, Color, and Back-Face. The 
Color and Shading settings are like Point Cloud ones except that “Face” is added in the Shading 
settings. “Face” utilizes the identical normal across the 3D model, rendering a flat shading across 
the faces. The Back-Face setting dictates the lighting conditions for the rear side of the 3D 
model, with choices including "Single" (no lighting on the back face), "Double" (illumination on 
both sides), "Fancy," or "Cull." These settings are highlighted in red in the subsequent image. 
Notably, not all files support the surface mode unless they contain the necessary surface 
information. 

 

 
Figure 12. 3D model in smooth surface mode. 

 
4.3: Lighting manipulation 

 
Whether your 3D model is rendered in point cloud, wireframe, or smooth surface mode, you 
have the option to manipulate the lighting to achieve the optimal viewing experience. To adjust 
the lighting, hold down "Shift + Ctrl" and drag using the left mouse button to alter the light's 
orientation. This quick access key combination can also be located by navigating to Help → On-
Screen Quick Help, or by pressing the F1 key. 

 
The Figure 13 below showcase the same 3D model rendered in smooth surface mode, but with 
lighting coming from a specific direction. Yellow stripes indicate the direction of the light 
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source. As the lighting shifts from one direction to another, the appearance of the 3D model also 
changes correspondingly. It's important to note that the file must contain surface normal for light 
manipulation to be supported. 
 

 
(a) 

 
(b) 

Figure 13.Lighting from two different directions on the same 3D model. 

4.4 3D model portion selection 
 

MeshLab allows selecting portion of the 3D model. It also allows the user to select multiple 
portions of the 3D model. Figure 14 shows two portions of the smooth surface selected through 
“Select face in a rectangular region”. 
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Ensure that the settings for "Selected Vertex" and "Selected Face" are correctly configured. 
Additional hotkeys for these settings are listed in the upper left corner of the model window. 
You also have the option to select individual points as shown in Figure 15 on the 3D model, as 
opposed to faces or vertices. 
 

 

 
Figure 14. Surface portion selection in MeshLab. 
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Figure 15. Point cloud portion selection in MeshLab. 

 
4.5: Apply edge decorators on 3D model 

 
By modifying the "Edge Decorators" settings, you can highlight edges within the 3D model. The 
subsequent Figure 16 illustrates the model with either "Boundary Edges" or "Boundary Faces" 
activated exclusively. 
 
The options for "Edge Decorators" are highlighted in red. Feel free to enable or disable these 
decorators based on your specific requirements. Note that multiple decorators can be activated 
simultaneously for a more comprehensive view. 
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(a) 

 
(b) 

Figure 16. Edge decorator for 3D model. (a) boundary edges on; (b) boundary faces on. 
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4.6: Measurement tool 
 

MeshLab allows users to measure the distance between two points. This function is controlled by 

the icon  
 

 
Figure 17. Measurement of two points in the 3D model through measurement tool 

The accompanying Figure 17 illustrates various elements: the "Measurement Tool" button is 
highlighted in red, the track line connecting the start and end points is enclosed in blue, and the 
distance information is marked in green. Users can perform multiple measurements, with each 
value displayed in the information window. Current measurement data, along with hotkey 
options for additional maneuvers, are displayed in the upper left corner of the model window. 
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4.6: Additional tricks 
 

 
Figure 18. On screen quick help menu. 

 
All the basic hot keys are listed on 3D model window when F1 is pressed or selecting “On screen 
quick help” under “Help”, as illustrated in Figure 18 above. 
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The background grid   shown in Figure 19 and drawing axis  shown in Figure 20 
provide reference to user to understand the location of the 3D model.  
The background grid settings can be modified in the layer dialog window. 
 

 
Figure 19. Background grid as reference for 3D model 
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Figure 20. Drawing XYZ axes in the world coordinate. 

 

The “Bounding Box”  feature shown in Figure 21 assists users in identifying the statistical 
dimensions of the 3D model. This provides valuable insights into whether the model falls within 
a reasonable range and if further modifications are necessary. 
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Figure 21. Bounding box of the 3D model. 

 
Detailed steps can be found in the demo video: MeshLab Demo Video -- Manipulating 3D data  
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5. 3D Visualization Screen Storage 
 

MeshLab provides the functionality to capture snapshots of your 3D model for future reference. 
When multiple 3D models are loaded into MeshLab, you have the option to either save all the 
models collectively or save each one individually. The user can access the snapshot function 

either through the File tab on the task bar or through the quick access button , as shown 
below in Figure 22. 
 

 
(a) 

 
(b) 

Figure 22. Snapshot access in MeshLab. (a) menu bar; (b) quick access button. 
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In the Snapshot dialog box, users have the option to specify the output folder location and define 
the file name for the snapshot. Additionally, the background of the snapshot can be customized. 
If the present options in the Snapshot dialog box don't meet your needs, you can navigate to 
"Tools" → "Options" to access more extensive settings for the background color, as illustrated 
below in Figure 23. 
 

 
Figure 23. Extensive settings for background color. 

By checking the “Snap All Layers”, MeshLab can generate separate snapshot of each 3D model. 
The Figure 24 shows the separate snapshot generated based on the 3D model of a shoe bottom 
and a shoe print. 
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(a) 

 
(b) 

Figure 24.Seperate snapshot of multiple 3D models. (a) shoe bottom; (b) footprint. 

The "Screen Multiplier" feature allows users to capture snapshots at a higher resolution. This is 
particularly useful when the snapshot is intended for high-quality print outputs like posters, 
requiring a resolution higher than the default. The value entered the Screen Multiplier window 
must be an integer. 
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When the "Tiled Save" option is unchecked, the snapshot will be a single image with enhanced 
resolution. If "Tiled Save" is enabled, the snapshot will produce N×N tiled screenshots, where 
each tile retains the default resolution. For example, a 2×2 tiled snapshot is shown individually 
below in Figure 25, generated based on the existing 3D model. 
 

 
(a) 

 
(b) 

 
(c) 

 
(d) 

Figure 25. 2x2 tiled snapshot. (a) upper left corner; (b) upper right corner; (c) lower left corner; (d) 
lower right corner. 

Detailed steps can be found in the demo video: MeshLab Demo Video -- Screen shots   
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6. Multiple 3D Models Visualization and Manipulation 
 
MeshLab supports the loading of multiple 3D models, and the Layer Dialog window enables 
users to manage the display settings for each individual model. For detailed steps on how to 
manipulate each 3D model, please refer to Section 3 of this tutorial. 
 
The following two images in Figure 26 shows the two 3D models displayed together and when 

one 3D model is not shown with clicking on  in the layer dialog window.  
 

 
(a) 
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(b) 

Figure 26. Multiple 3D model visualization control. (a) footprint is shown; (b) footprint is hidden; 
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Inside MeshLab, each 3D model is called a layer. The settings for display can be controlled to be 
applied to each individual layer or all layers (all 3D models). For each individual layer, the user 
can apply additional maneuvers by right clicking on the layer, as shown below in Figure 27. 

 

 
Figure 27. Individual layer manuver options. 

 
Detailed steps can be found in the demo video: MeshLab Demo Video -- Loading multiple 3D 
models  
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7. Multiple Aligned 3D Models Visualizaiton and Manipulation  
 
MeshLab enables users to control the display of individual 3D models when multiple models are 
loaded. The interface allows users to toggle the visibility of each model, as depicted in the 
example below featuring multiple aligned 3D models in MeshLab. The display status of each 

model is controlled by , as illustrated below in Error! Reference source not found.. 
 

 
(a) 
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(b) 

Figure 28. Indivial layer display or hidden control button. (a) second layer in color blue is shown; (b) 
second layer is hidden. 
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The measurement tool in Section 3.f is versatile, allowing users to measure point-to-point 
distances across different 3D models. The accompanying Figure 29 demonstrates this 
functionality using the grey tire 3D model and the blue tire 3D model, both of which are aligned. 
By simply employing the measurement tool for point-to-point distance measurement, users can 
identify the distance between two points. 
 

 
Figure 29. Measurement across aligned multiple 3D models. 

 
Detailed steps can be found n the demo video: MeshLab Demo Video -- Measurement across 
models  


